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1 ¢Queé es LIMP?

LIMP es un programa disefiado para la medicion de la impedancia de altavoces y la estimacién de los
parametros fisicos y dinamicos de los altavoces (también llamado parametros Thicle-Small). Es
también un programa de uso general para medir la impedancia entre 1 y 200 ohmios.

Los requisitos para usar el LIMP son:

0 Sistemas operativos: Windows 98/Me/2000/XP
0 Procesador Pentium, frecuencia del reloj 400 MHz o superior, memoria 128 MB
o Tarjeta de sonido duplex completa

El LIMP se ha usado con resultados satisfactorios con las siguientes tarjetas de sonido:

RME Fireface 800, RME HDSP

M-audio Audiophile 2496, USB Transit, Delta 44,

Terratec EWX 24/96

Digigram VxPocket 440 — una tarjeta PCMCIA para portatil

Echo Layla 24

Tarjetas de sonido profesionales YAMAHA y DAL

TASCAM US-122 - USB audio

Ego-Sys U24 USB y Waveterminal,

Soundblaster Live 24 y Extigy-USB (pero solo a la frecuencia de muestreo de 48kHz),
Tarjetas Turtle Beach Pinnacle y Fuji,

O 0O O0OO0OO0OO0OO0OO0OO0OOo

El LIMP se puede usar con un rendimiento ligeramente inferior con las siguientes tarjetas:

0 Soundblaster MP3+ USB (nota: no instale un controlador SB, use el controlador por defecto
de Windows XP),

0 Tarjetas de sonido y audio incorporado con codecs AC97 (problema con ruido elevado en el
modo FTT).

La instalacion del programa se realiza a través del programa de configuracion comun para el software
ARTA.

Todos los datos de registro de Windows para LIMP se guardaran automaticamente en el momento en
que se ejecute el programa por primera vez, y se archivara la extension ".LIM" para que se abra con el
programa LIMP.

Los resultados de la medicion se pueden guardar también como archivos formateados en ASCII con
extension .ZMA.

El LIMP no envia los graficos a la impresora, pero se pueden copiar todos los graficos en el
Portapapeles de Windows y pegar en otras aplicaciones de Windows.



2 Teoria sobre medicion de la impedancia

2.1 Circuito basico para medicién de la impedancia

La medicion de la impedancia de un altavoz se basa en el sistema que aparece en la [lustracion 2.1. La
resistencia de referencia R se conecta entre el generador de sefial y una impedancia de altavoz Z.
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lustracion 2.1 Circuito para medicion de la impedancia de un altavoz

La impedancia se define en el dominio de la frecuencia - Z (f ). Si medimos los voltajes U; (f) y U, (f
), a ambos extremos de la resistencia de referencia, se estima la impedancia del altavoz como:

UL (H)-U,(f) M

2.2 Generador de sinusoides escalonadas y de ruido periédico Rosa

El LIMP tiene dos modos de medicién de impedancia:

1) Modo de sinusoide escalonada
2) Modo FFT con excitacion de ruido periodico rosa (Pink PN)

En la modalidad de modo sinusoide escalonada LIMP genera rafagas de sefiales sinusoidales puras,
frecuencia por frecuencia en incrementos de 1/24 o 1/48 octavas, y mide la respuesta a la sefial
sinusoidal filtrando el ruido y los componentes de distorsion de la respuesta sinusoidal.

La modalidad FFT es un método mas rapido para medir la impedancia, pero con una relacion
Sefial/Ruido (S/N) de medicion mucho menor que el modo sinusoide escalonada. En este modo, el
LIMP mide simultdneamente los valores de la impedancia en toda la gama de frecuencias audibles
usando el generador de sefial con una excitacion de ruido rosa periddica en banda ancha (Pink PN).

La excitacion de ruido rosa en banda ancha se efectiia como sefales multisinusoidales de fase aleatoria
periddica. Es una sefial periddica de cero dc que contiene M componentes sinusoidales, cada uno con
una fase aleatoria:

M
gt)= z A cos(2zkf t+¢,), ¢, =randome[0,27]
P 2)



Esta onda multisinusoidal tiene Ay =V2Ay y sus magnitudes espectrales se reducen 3dB/oct (después
de cierta frecuencia de corte). En el LIMP, la frecuencia de corte de baja frecuencia variable se puede
cambiar en el cuadro de didlogo 'Signal Generator Setup' [Configuracién del generador de sefiales]
El ruido rosa se suele usar con una frecuencia de corte cercana a la frecuencia en la que el altavoz
tiene el maximo de impedancia (20-100Hz). El ruido periddico rosa tiene la distribucion estadistica
mas cercana a la distribucion normal, y en LIMP se genera con un factor de cresta inferior a 12dB.

2.3 Procedimiento simple de medicién
En el modo sinusoide escalonada, el procedimiento simple de medicion es el siguiente:

1. El LIMP genera una rafaga de sefial sinusoidal con una frecuencia f. Asumimos que esta sefial
acciona el generador que aparece en la [lustracion 2.1.

2. Después de un periodo transitorio arbitrario, que es necesario para alcanzar el estado
estacionario, se miden los voltajes a ambos extremos de la resistencia de referencia, con la forma
de series de tiempo discretas U, y U, de longitud N.

3. La magnitud y la fase de la sefial U, y U, a la frecuencia f se calculan hallando los componentes
sinusoidales fundamentales U, y U, a la frecuencia del generador f. Se hace resolviendo
directamente la integral de Fourier en el tiempo de integracion T. Estos armonicos
fundamentales se usan en la ecuacién (1) para calcular la impedancia Z.

4. Después de cierto periodo arbitrario, que llamamos pausa entre rafagas, que sera necesaria para
que el sistema medido libere la energia reactiva, la frecuencia se incrementa en 1/24 octava (o
1/48 octava) y se repite el proceso desde el paso 1) hasta que se alcanza la frecuencia de parada
predefinida.

En el modo FFT, el procedimiento simple de medicion es el siguiente:

1. El LIMP genera el Ruido Rosa PN como secuencia periddica discreta con un periodo igual a N.
Asumimos que esta secuencia acciona el generador que aparece en la [lustracion 2.1.

2. Después de un ciclo de compensacion, que es necesario para alcanzar el estado estacionario, se
miden los voltajes a ambos extremos de la resistencia de referencia, con la forma de series de
tiempo discretas U, y U, de longitud N.

3. EI DFT se aplica a las series de tiempos U, y U, para obtener los componentes espectrales U; (f) y
U,(f). Estos se usan en la ecuacion (1) para calcular la impedancia Z(f).

Nota importante:

La generacion de sefal en el modo sinusoide escalonada genera unos componentes sinusoidales con un
nivel al menos 30dB superior a lo que es posible en el modo FFT. Esta es la razon por la que en el
modo FFT los resultados de las mediciones pueden estar enormemente afectados por el ruido que se
genera en el altavoz medido.




2.4 Mediciones en un entorno ruidoso

La principal fuente del ruido de medicion es un altavoz que actia como microéfono del ruido y las
vibraciones medioambientales. La Ilustracion 2.2 muestra el circuito modificado para la medicion de
la impedancia del altavoz, que incluye el generador de ruido E,.

lustracidn 2.2 Circuito para la medicion de la impedancia del altavoz, incluyendo el generador de
ruido E,.

Si aplicamos las ecuaciones de medicion de la impedancia (1) a este circuito, obtenemos el valor
estimado de la impedancia:

_R R+Z+Rg

Zestimated - U U = +1
=Y, +Eg/En

3)

Lo que evidencia esta ecuacion es que la impedancia estimada difiere de la impedancia real Z
porque es dependiente de la relacion sefial/ruido (EJ/E,) y de los valores de las resistencias R,
R, y la impedancia Z. Concluimos entonces que:

1. El generador de sefiales ha de suministrar un voltaje elevado, para garantizar una relacion
sefial/ruido alta. En la préctica, necesitamos un generador con al menos 1V de voltaje de salida
pico. Esto se puede conseguir facilmente con la excitacion sinusoidal escalonada.

2. Cuando usamos el método FFT, los resultados de la medicion se ven muy afectados por el
ruido. El altavoz actiia como micréfono con una sensibilidad mas alta en la region de la
resonancia de la membrana. Esto implica que el nivel mas alto de ruido se encuentra en las
frecuencias bajas, asi que hemos de generar la sefial con el nivel mas alto en las frecuencias
bajas, es decir, el ruido rosa.

3. Los valores de las resistencias R y R, han de ser bajos, encontrandose el valor éptimo cerca de
la magnitud de la impedancia medida. En realidad, podremos usar R = 10-27 Ohmios para
obtener una buena estimacion de la impedancia, pero entonces necesitaremos un amplificador
de potencia que suministre mucha corriente. Si usamos la salida de teléfono de la tarjeta de
sonido como generador de sefial, entonces podremos usar R=47-100 Ohmios. Si usamos la
salida de linea de la tarjeta de sonido como generador de la sefial, debido a su capacidad de
corriente limitada, hemos de usar R>600 Ohmios. En ese caso, no obtendremos una buena
estimacion con el método FFT, pero aun podremos usar el método de sinusoide escalonada.



2.4.1 Reduciendo el ruido de medicion en el modo sinusoide escalonada

En el modo sinusoide escalonada LIMP usa el principio "heterodino" para filtrar todos los
componentes espectrales que quedan fuera de la banda de paso que se centra en la frecuencia medida.
El ancho de banda del filtro es igual a 1/T, siento T el tiempo de integracion de la integral de Fourier.
Por ejemplo, si usamos un tiempo de integracion de 200 ms, el ancho de la banda de paso del filtro
"heterodino" es de 5 Hz.

2.4.2 Reduccion del ruido de medicion en el modo FFT con excitacion de ruido
periodico

El ruido se puede reducir parcialmente usando la técnica de compensacion en la estimacion de
U, y U, EI LIMP compensa el espectro automatico de U1 y el espectro cruzado de U; y U,
dando la siguiente impedancia estimada:

z

(4)

Nota: los corchetes <> indican valores compensados y el asterisco sefiala un valor complejo
conjugado.

Se pueden aplicar dos tipos de compensacion en el LIMP. En una "compensacién sincrénica en el
dominio temporal” el LIMP genera multiples periodos de una secuencia de ruido (Ilustracion 2.3). En
una "compensacion asincronica en el dominio de la frecuencia" el LIMP genera una secuencia de
ruido diferente para cada bloque de FFT adquirido (Ilustracién 2.4). La Compensacion Asincronica del
Dominio de la Frecuencia nos puede dar unos resultados ligeramente mejores que la compensacion
sincronica en los sistemas que tienen una distorsion no lineal, pero requiere un tiempo mayor para
hacer las mediciones.

Pra-

averaging Measurement
| | | | | Generated signal
PM noise
FFT blkack  FFT block FFT block  FFT block
Acquired

I | | | | signalz ul and u2

lustracion 2.3 Generacion y adquisicion de sefal durante el proceso de compensacion sincronica en
el dominio temporal.

Pra-_ | | Pra- |
averaging Fausa averaging
Generated signals
1
| 1 | | 2 | 2 | PM noise
FFT block FFT block

l:l I:l Acquired signals

lHustracion 2.4 Generacion y adquisicion de seial durante la compensacion asincronica en el dominio
de la frecuencia.



3. Configuracion de hardware

La configuracion de medicion mas simple es la que se muestra en la Ilustracion 3.1. La salida de
teléfono de la tarjeta de sonido (o la salida del altavoz) se usa como salida del generador de sefiales. La
entrada de linea izquierda de la tarjeta de sonido se usa para registrar el voltaje U, y la entrada de linea
derecha de la tarjeta de sonido se usa para registrar el voltaje U..

Nota: Si la tarjeta de sonido no tiene salida de teléfono o de altavoz, entonces habremos de usar la
salida de linea y un amplificador de potencia exterior, como se muestra en la [lustracion 3.2.

Fhone

A
out
R=100
ohm

right in L
lHustracion 3.1 Configuracion de : ::E_‘ Loudspeaker
medicion para realizar left in —
mediciones de la impedancia del anundeard
altavoz, usando la salida de
teléfono.
left out I
Powear 2? ohm
amplifier
right in |
., ., Voltage probe
lustracion 3.2 Configuracion de : Loudspeaker
medicion general para left in e
mediciones de impedancia de eoundcard

altavoces

Para proteger la entrada de la tarjeta de sonido frente a los voltajes elevados que se generan en la
salida del amplificador de potencia, se recomienda usar el circuito de sonda de voltaje con diodos
Zener, como aparece en la [lustracion 1.3. Los valores de las resistencias R1 y R2 se han de elegir para
una atenuacion arbitraria (es decir que R1=8200 y R2=910 ohmios nos da una sonda con una
atenuacion de -20,7 dB (0,0923) si la tarjeta de sonido tiene una impedancia normal de entrada de -
10kU). En el modo de canal tnico, esta sonda no se conecta.

D—f‘\J;\ {"v ﬁ a

., . Power Sound
llustracion 3.3 Sonda de voltaje  amplifier | R2 Card
con proteccion frente a Output Zener ZS input
sobrecarga del canal de entrada 5 41 o

de la tarjeta de sonido.
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4 Trabajar con LIMP

Al arrancar el LIMP aparecera la ventana del programa que aparece en la ilustracion 4.1. Tenemos:
Barra de menus, barra de herramientas y barra de didlogo en la parte superior de la ventana, y la barra
de estado en la parte inferior de la ventana.

La parte central de la ventana mostrara el diagrama de magnitud y fase.

A} untitled - Limp -0 =|
File Owverlay Edit View Record Setup Analyze Help
| fr mw|» ®|cal| N = | Mag|mer
Gen | Fink PN | FstatHz [ 40 =] FstopiHa) [ 20000 Avg [Linesr ] Reset
Magnitude(ohms) Impedance FPhase (%) Max
50.0 0.0 -
45.0 45.0 ﬂ
40.0 0.0
Fit
a5.0 -45.0
Miri
20.0 800
F
250 g0 ﬂ
20,0
150 set
L
100 I FrHigh
. I O
oo 100 1000 10000 Friow
Cursor: 5.0 Hz, 0.00 Ohm, 0.0 deg Frequency{Hz) J I ’I
Ready [L:0dB  |[R:0dB | Impedance Measurement
llustracion 4.1 Ventana principal del programa
Cpen Copy to Thick Stop Measurament Wiew

file clipboard lines recording setup magnitude

A

S EH( 7y m| > @A N ] Mag e

LI Y A R

Save Background Start Calibrate Generator Wiew
file color recording inputs satup magn. + phasze

llustracién 4.2 Iconos de la barra de herramientas



Ready |L:0dB  |R:0dB | Impedance Measurement

llustracion 4.3 La barra de estado muestra el nivel pico (ref. escala completa) de las entradas en la
linea izquierda y derecha

Eenerator Samplhg Size of Axeraging Rezet
tpe Frequeng [Hz) FFT block tupe averaging

} } } | }
Gen [Fik PN | FsiHz) [44100 =] FFTsiee [32768 | avg [None =] Rese]

v F
=

Changes graph maximum-magnitude margin

Fit magnitude graph margins

Changes graph minimum-magnitude margin

Opens dialog for setup of graph margins

3l s

Changes graph high-frequency margin

~§
=

-

Changes graph lowes!-frequency margin

llustracion 4.4 Barras de didlogo superior y derecha

Normalmente, trabajamos con las ventanas de graficos y los cuadros de didlogo También necesitamos
tener una copia del grafico o de la imagen de la ventana de graficos.

Sera simple copiar la imagen de la ventana completa. Pulse simultineamente las teclas Ctrl+P. Una
vez pulsado el comando se guardara la imagen de la ventana en el Portapapeles, desde el que el
usuario podra copiarlo en otras aplicaciones de Windows (MS Word, MS Paint y Adobe Paint Shop).

Para conseguir la copia de la imagen del grafico que hay dentro de la ventana, el usuario ha de pulsar
al tiempo las teclas Ctrl+C o activar el comando de ment 'Edit->Copy" [Editar > Copiar], o pulsar
el boton correspondiente de "*Copy* [Copiar].

En la barra de herramientas de la ventana principal, el boton 'Copy' [Copiar] aparece con el icono Qo

10



1) En el cuadro de edicidn el usuario introduce de forma opcional el texto que se
afiadira en la parte inferior del grafico.

2) La casilla de verificacion 'Add filename and date' [Afiadir nombre de archivo y
fecha] permite afiadir texto al grafico que indica el nombre del archivo, la fecha y
hora.

3) Se seleccionara Tamarfo del mapa de bits seleccionando uno de los siguientes
elementos de caja combinada:

»  Current screen size [Tamaifio de la pantalla actual] - opcion de ancho y
altura variable

= Smallest [Mas pequeiio] (400 pts) - grafico de ancho fijo con 400 puntos

*  Small [Pequefio] (512 pts) - grafico de ancho fijo con 512 puntos

*  Medium [Medio] (600 pts) - grafico de ancho fijo con 600 puntos

= Large [Grande] (800 pts) - grafico de ancho fijo con 800 puntos

= Largest [Mas grande] (1024 pts) - grafico de ancho fijo con 1024
puntos

Las opciones de ancho fijo proporcionan a la copia del grafico la relacion de aspecto
3:2.

Pulsando el boton 'OK' se copia el grafico al portapapeles del sistema.
Si se pulsa el boton 'Cancel' [Cancelar] se cancela la operacion de copia.

Copy to Clipboard with Extended Information ﬂ

Enter text that will be drawn on the bottom of the graph copy

I My comment: ...... |

Choose bitmap size I Current window size j

Add filename and date [ Cancel | oK I

llustracion 4.5 Cuadro de dialogo Copia al portapapeles con informacién ampliada
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4.1 Menus de LIMP

A continuacion se explican brevemente los menus de LIMP.

File [Archivo]

New [Nuevo] - inicializa el contenido de un nuevo archivo

Open [Abrir] - abre un archivo de impedancia existente (*.LIM)

Save [Guardar] — guarda el archivo con el nombre actual

Save As [Guardar como] — guarda el archivo con un nombre nuevo

Info [Informacién] — muestra la informacion sobre el archivo actual

Export ASCII [Exportar a ASCII] - exporta el contenido del archivo a un archivo de texto ASCII.
Commented . TXT file [Archivo TXT con comentarios] — exporta el archivo de texto con
comentarios y columnas con la frecuencia, la magnitud de la impedancia y la fase.
Plain .ZMA file [Archivo ZMA simple] — exporta el archivo de texto y columnas con los valores
de frecuencia, la magnitud de la impedancia y la fase.

Recent File [Archivos recientes] — abre un archivo que se haya abierto recientemente

Exit [Salir] — Sale del programa

Overlay [Superposicion]

Set as overlay [Establecer superposicion] — se fija la curva de impedancia actual como superposicion
Delete [Borrar] — borra la superposicion
Load [Cargar] — carga una superposicion de un archivo de impedancia

Edit [Editar]

Copy [Copiar] — copia el grafico como mapa de bits al portapapeles

Setup colors and grid style [Configurar los colores y estilo de la cuadricula] — configura los colores
del grafico y el estilo de la cuadricula

B/W Color [Color Blanco/Negro] - cambia el color del fondo a blanco o negro

Use thick pen [Usar trazo grueso] -usa un trazo grueso para trazar las curvas

View [Ver]

Toolbar [Barra de herramientas] — muestra u oculta la barra de herramientas

Status Bar [Barra de estado] — muestra u oculta la barra de estado

Fit graph range [Ajustar el margen del grafico] — cambia el margen superior del grafico para mostrar
la curva de impedancia completa

Magnitude [Magnitud] — muestra s6lo la curva de la magnitud de la impedancia

Magnitude +phase [Magnitud + fase] — muestra las curvas de magnitud de la impedancia y fase

Record [Registro]

Start [Inicio] — comienza a registrar (medicion)
Stop [Fin] — se detiene el registro (medicion)
Calibrate [calibrar] — abre el cuadro de didlogo de calibracion de los canales de entrada

Setup [Configuracidn]

Audio devices [Dispositivos de audio] — configura los dispositivos actuales de entrada y salida
Generator [Generador] — ajusta los parametros del generador

Measuremente [Medicion] — ajusta los parametros de medicion

Graph [Grafico] — Ajusta los margenes el grafico
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Analyze [Analizar]

Loudspeaker parameters — Added mass method [Parametros del altavoz — método de la masa
afladida] - muestra el cuadro de dialogo para estimar los parametros del altavoz empleando el método de
la masa afiadida

Loudspeaker parameters — Closed box method [Parametros del altavoz — método de la caja
cerrada] - muestra el cuadro de didlogo para estimar los parametros del altavoz empleando el método de

la Caja cerrada
RLC impedance values at cursor position [Valores de impedancia RLC en el cursor] - estima los
valores de impedancia de los elementos RLC en serie.

Help [Ayuda]

About [Acerca de]—proporciona informacion sobre el LIMP
Registration [Registro] — muestra la informacion de registro de la licencia de usuario
User Manual [Manual de usuario] - muestra el archivo de ayuda

Las siguientes son teclas Gtiles de acceso directo:

Teclas arriba y abajo - cambian el margen del grafico superior

Teclas izquierda y derecha - mueven el cursor hacia la izquierda y la derecha

Tecla Ctrl + S — guardan el archivo

Tecla Ctrl + N — crean un nuevo archivo

Tecla Ctrl + O — abren el archivo

Tecla Ctrl + C - copia un grafico de mapa de bits al portapapeles (con las opciones definidas por el
usuario)

Tecla Ctrl + P — copia el toda la ventana como mapa de bits al portapapeles

Tecla Ctrl + B — cambia el color del fondo
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4.2 Configuracion de la tarjeta de sonido

Active el mena Configuracion > Dispositivos de audio. Obtendra el cuadro de didlogo 'Soundcard
Setup’ [Configuracion de la tarjeta de sonido] que aparece en la ilustracion 4.6. En este cuadro de
didlogo ha de escoger la tarjeta de sonido que se usara como dispositivo de entrada o salida.
Generalmente, escogera la misma tarjeta como dispositivo de entrada y salida.

Soundcard Setup x|

Wave [nput Device

Wave Output Device IEW'>< 24496 Wave Analog j

Cancel | | ] 4 I

lHustracion 4.6 Configuracion de la tarjeta de sonido

Nota importante: Enmudezca los canales de sefial y micrdfono de la mezcladora de salida
de la tarjeta de sonido (llustracion 4.7). De no hacerlo asi puede obtener una
retroalimentacién positiva durante las mediciones. Si usa una tarjeta de sonido
profesional, desactive el control directo (también denominado control de latencia cero).

~iEix
Options  Help
bd azter Wolume W ave CD Audio Line In Mizrophione
Balance: Balance: Balance: B alance: Balance:
YWalume: Yaolume: Wolurne: Yolurme; Wolurme:

| i E T ~ -
[ Mute all [ bute [~ Mute v bdute v Mute

Advanced | Advanced |

|Inte|{r]| Inteqrated Audio

lustracion 4.7 Configuracion tipica de la salida de la mezcladora de la tarjeta de sonido
(reproduccion) (la encontrara en el programa del panel de control 'Sound and Audio Devices'
[Dispositivos de sonido y audio])



4.3 Configuracion del generador

Hay dos tipos de sefiales de excitacion posibles en el LIMP

e Sinusoide
¢ Ruido periédico rosa (Pink PN).

Escoja el tipo de sefial en la barra de didlogo superior o en el cuadro de didlogo 'Generator Setup’
[Configuracion del generador] que aparece en la Ilustracion 4.8. Llegara a este cuadro de dialogo

haciendo clic sobre Configuracion > Generador o sobre el icono de la barra de herramientas [,

Generator Setup El

—Generator

Type I Sine """I Sine freq. (Hz) 1000
Output level |-3dB "’I Fink cut-off (Hz) I 20

Input level monitor

L I 70 I 0 I 30 I -10 | a8
80 I 50 || -40 I -0 I )

Test Cancel | Ok I

llustracion 4.8 Configuracion del generador de sefiales

El didlogo Configuracion del generador tiene los siguientes controles:

Type [Tipo] — selecciona la sefal de excitacion: Sine [Sinusoide] o Pink PN [Ruido rosa]

Sine freq. (Hz) [Frecuencia sinusoidal (Hz)] - introduce la frecuencia de prueba del generador de
ondas sinusoidales

Pink cut-off (Hz) [Corte rosa (Hz)] — introduce la frecuencia baja de corte del generador de ruido rosa

Output level (dB) [Nivel de salida (dB)] — elige el nivel de salida (0-15dB)

Test [Prueba] — comienza/detiene el generador con las configuraciones actuales

Input level monitor [Monitor de nivel de entrada] — el medidor del pico de volumen de entrada. Las
barras del medidor tienen los siguientes colores:

Verde (para niveles inferiores a -3dB),
Amarillo (para niveles entre -3dB y 0dB) y
Rojo (para sobrecarga de la entrada).

Recomendacion:

e Para obtener los resultados mas fiables use el generador de ondas sinusoidales, pero no haga
que el altavoz tenga un desplazamiento grande (el mayor desplazamiento se produce a
frecuencias por debajo de la frecuencia de resonancia del altavoz).

o Para las mediciones de los altavoces de graves y de medios graves ajuste la frecuencia de
corte rosa cerca de la frecuencia de resonancia del altavoz (20-100 Hz).

e Pulse el boton Test [Prueba] para controlar los niveles de entrada/salida. Si las barras del
medidor pico son de color rojo, los canales de entrada estan sobrecargados. Baje el volumen
de salida hasta que las barras pasen a ser de color amarillo o verde.
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4.4 Configuracion de la medicién

Para configurar los parametros de medicion use el cuadro de dialogo "Measurement setup’
[Configuracion de la medicion], que aparece en la ilustracion 4.9. Llegara a este cuadro de dialogo

haciendo clic sobre Configuracion > Medicion o sobre el icono de la barra de herramientas (g

Measurement Setup ﬂ

—Meazurement config————— — Stepped zine mode —FFT mode [pink noize excitation]

Fieterence channel ILeft 'I Frequency increment I'IME oCtave "’I FFT size |32?EE "’I
Reference Resistor IE;E“:I Mir. inteqration trme [ms] 200 Aseraging INDr‘IE "’I

— Freguency range [Hz]

High cut-off |2':"3”'3

Lowy cut-off |3|:|
Sampling rate [Hz] |4E=EIEIEI vI

Tranzient time [mz] 100 tax averages 100

Intra burst pavse (ms) 100 Azynchronous averaging [

Drefault | Cancel | ak. I

lHustracion 4.9 Configuracion de la medicion

El dialogo Configuracién de la medicion tiene los siguientes controles:

En la seccion Measurement config [Config. Mediciéon]:
Reference channel [Canal de referencia] — establece el canal de referencia (U,) a: Izquierda o derecha
Reference resistor [Resistencia de referencia] — introduce el valor de la resistencia de referencia

En la seccion Frequency range [Gama de frecuencias]:
High cut-off [Corte alto] — introduce el margen de la frecuencia superior de medicion
Low cut-off [Corte bajo] — introduce el margen de la frecuencia inferior de medicion

Sampling rate (Hz) [Frecuencia de muestreo (Hz)] — elige la frecuencia de muestreo (de 8000 a
96000 Hz)

En la seccion Stepped sine mode [Modo sinusoide escalonada]:
Frequency increment [Incremento de frecuencia] — establecido a 1/24 o 1/48 de octava

Min. integration time (ms) [Tiempo de integracién minimo (ms)] - introduce el tiempo de integracion
minimo (los valores mas elevados proporcionan una mayor reduccion del ruido)
Transient time (ms) [Tiempo transitorio (ms)] — introduce el tiempo transitorio para permitir al sistema
alcanzar el estado estacionario (antes de comenzar la integracion)
Intra burst pause (ms) [Pausa entre rafagas (ms)] — introduce el tiempo que precisa el sistema para
liberar la energia de los componentes reactivos.

En la seccion FFT mode (pink noise excitation) [Modo FFT (excitacion de ruido rosa)]:

FFT size [Tamafio FFT] - elige la longitud del bloque FFT (32768 0 65536)

Type [Tipo] — Elegir: Ninguno, media lineal o media exponencial

Max. Averages [Compensacién maxima] — introduce el nimero maximo de compensaciones para el
modo 'lineal'

Asynchronous averaging [Compensacion asincronica] — verifique esta casilla para usar la
compensacion medias asincronica
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4.5 Procedimiento de medicion

Una vez que haya completado la configuracion del dispositivo de audio, la configuracion del
generador y la configuracion de la medicion, ya esta listo para realizar las mediciones.

a) Procedimiento en la modalidad FFT
Conectar los altavoces en la forma de prueba (Ilustracion 3.1 o 3.2) y hacer clic sobre Registro >

Inicio o haga clic sobre el icono de la barra de herramientas » Las mediciones se repetiran de
forma periddica y los resultados se mostrardan como un grafico de impedancia. Obtendra un grafico
como el que aparece en la ilustracion 4.10. Podra detener las mediciones haciendo clic sobre Registro

> Fin o sobre el icono de la barra de herramientas ® .

Podra copiar el grafico en formato de mapa de bits haciendo clic sobre Editar > Copiar o sobre el
icono de la barra de herramientas =¥ .

Magnitude{ohms) Impedance Fhase(deg)
30.0
27.0 — e 450
_,.u_,_..—'—""_'_ [ -v—F_-'-_FM
240 == 0.0
\"'-\_
21.0 "] -45.0
18.0 -80.0
15.0 f/_:""*
12.0 J_,-"'J
2.0 e
_F,.ﬂ'
6.0 -~
|t \L\""-—»u- =TT
3.0 .
Avg:
0. 100 1000 10000
Cursor: 985.5 Hz, 4.84 Ohm, 20.9 deg Frequency(Hz)

lustracion 4.10 Medicion de la impedancia sin aplicar compensaciones — una medicion ruidosa

Si escoge una aplicacion de compensacion Lineal, las mediciones se repetiran y se compensaran hasta
que el nimero de compensaciones alcance el valor predefinido en Compensaciones maximas en el
cuadro de dialogo de la Configuracion de la medicion. Podra detener la compensacion en cualquier
momento haciendo clic sobre Registro > Fin o sobre el icono de la barra de herramientas

® iError! Nombre de archivo no especificado.. Obtendra un grafico como el que aparece en la
ilustracion 4.11.

Magnitudelohms) Impedance Fhase(deg)
0 80
270 — m——— S e
[ =y IE—
240 == 0.0
I
210 = el -a5.0
18.0 -80.0
15.0 ff
120 H
| ]
9.0 e
80 /] ]
_'_'_J_'_,_.-"‘- \-‘"'H—\__\_.\__,w__u——n——"'_—'f
2.0 .
Avg2
0.0 100 1000 10000
Cursor: 9855 Hz, 482 Chm, 21.3 deg Frequency(Hz)

lustracion 4.11 Mediciones de la impedancia con compensacion
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También podra seleccionar la aplicacion de medias exponenciales. Difiere de las medias lineales en
una forma que concede mas importancia a los resultados de las cinco ultimas mediciones.

a) Procedimiento en el modo sinusoide escalonada

Los procedimientos de medicion en el modo sinusoide escalonada son casi igual que en el modo FFT.
La tinica diferencia es que en el modo FFT el usuario vera el grafico de impedancia de toda la gama de
frecuencias medidas casi instantaneamente, mientras que con el procedimiento del modo sinusoide
escalonada se repetird para muchas frecuencias. El cursor mostrara el progreso real en las mediciones,
y ese proceso sera muy lento.

4.6 Configuracion y exploracion de gréaficos

El comando de menu Configuracion > Configuracion de graficos (o haciendo clic con el bot6n
derecho del ratén en la zona del gréfico) abre el cuadro de dialogo 'Configuracion del grafico' que
se muestra en la ilustracion 4.12. Use este cuadro de didlogo para ajustar la gama de la magnitud de
impedancia que se muestra asi como la gama de frecuencias visible.

Graph Setup x|

Imedance range [ohm) Freq. range [Hz]

[araph range IEEI High |2EIEIEIEI
Graph bottom ID Lo |2EI

Update |

Cancel |

I# | Visw Phase View al | oK |

llustracion 4.12 Configuracion de graficos
El cuadro de dialogo Configuracion de gréficos tiene los siguientes controles:

Seccion Impedance range (ohm) [Gama de impedancias (chmios)]:

Graph range [Gama del gréafico] — introduce la gama de magnitud de impedancia

Graph bottom [Fondo del gréfico] — introduce el margen inferior del grafico para la magnitud de
impedancia

Seccion Freg. range (Hz) [Gama de frecuencias (Hz)]:
High [Alta] - introduce la frecuencia mas elevada que se muestra (en Hz)
Low [Baja] - introduce la frecuencia mas baja que se muestra (en Hz)

View All [Ver todos] — permite ver todos los componentes del espectro DFT que se usan en la estimacion de la
impedancia.

View Phase [Ver fase] — permite dibujar un grafico de fase.

Update [Actualizar] — pulse este boton para actualizar el grafico con una nueva configuracion.

Los colores del grafico se pueden cambiar de dos formas. La primera es cambiar al color del fondo de
"Negro" a "Blanco" haciendo clic sobre el comando del ment Ver > Color B/N o sobre el icono de la
barra de herramientas ¥ .
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La segunda forma de cambiar los colores del grafico es con el "modo de usuario". El usuario indica un
colocar arbitrario para cada elemento del grafico usando el cuadro de didlogo "Color setup’
[Configuracion del color], que aparece en la ilustracion 4.13. Este cuadro de dialogo se puede
activar haciendo clic sobre el menti Editar > Colores.

Color Setup x|

Graph Background
Graph border

Plat pen color 1
Plot pen color 2
Merge pen color
Grid color
SubGrdColar

Cursor color

LTI

Marker color

Lse dotted graph grid [V

Defast |  Cancel | ok |

lustracion 4.13 Cuadros de dialogo para la configuracion de los colores del grafico

Haciendo clic con el boton izquierdo del raton sobre un rectangulo de color se abre el cuadro de
dialogo estandar de Windows 'Color’ (Ilustracion 4.14). El boton 'Default’ [Defecto] restaura los
colores por defecto.

La casilla de verificacion 'Use dotted graph grid' [Usar una cuadricula de puntos] permite crear
una cuadricula con lineas de puntos.

Basic colors:
R W=
RN
FHEE NN
EEEENEN
EEEEEN
0 el
Custom colors:
.
[ W 0NNy
Define Custom Colors »» |
Ok, I Cancel |

lustracion 4.14 Dialogo estandar de Windows para la configuracion del color

Podremos explorar el grafico moviendo el cursor. En la parte inferior del grafico, la etiqueta 'Cursor":
Indica los valores de la magnitud y la fase en la posicion del cursor.
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4.9 Mediciones calibradas

En las mediciones descritas con anterioridad hemos asumido que ambos canales de entrada de la
tarjeta de sonido tienen la misma sensibilidad, pero normalmente esto no es cierto. Si la diferencia de
sensibilidad de los canales de entrada es mayor de 0,2 dB, hemos de hacer una calibracion.

El LIMP dispone de un procedimiento de calibracion incorporado. Se ha de hacer para una longitud de
secuencia de generador y una frecuencia de muestreo concreta.

En el procedimiento de calibracion, ambos canales de entrada han de estar conectados a la
salida del generador.

Haciendo clic sobre el menu Registro > Calibrar o sobre el icono de la barra de herramientas CAL,

obtendremos el cuadro de dialogo 'Calibrate Input Channels' [Calibrar canales de entrada] que se
muestra en la ilustracion 4.15.

Calibrate Input Channels x|

—Generate —Calibrate ~Status

Sea. length e Connect left and right input Calibrated for;

=4 1=ng 52768 channel to signal generator
I .
Sampling rate IF output ! Seq.length: 32768
Mumber of averages Fs: 43000 Hz
=1
Output volume (dB) |-3d8 b I 1 — Channel diff: 0.15dB
Generate | Calibrate | Uncalibrate |
Input Level Maonitor
Cancel |

L I -0 I 50 I a0 I -1 a5
B 80 I 50 I -40 I 20 1 o5 aK I

lHustracion 4.15 Dialogo para calibrar la sensibilidad de los canales de entrada

En la seccion Generate [Generar] establecemos el volumen de salida de la sefial de Ruido Rosa o la
frecuencia de muestreo y longitud de la secuencia conocida. Pulsando el boton 'Generate' [Generar]
se activa la generacion de seial y el control de los niveles de entrada en el Medidor de nivel de
entrada. Si fuera necesario, podremos ajustar el volumen de salida usando la caja combinada 'Output
volume [Volumen de salida].

Finalmente, en la seccion Calibrate [Calibrar] se introduce el Number of averages [NUmero de
compensaciones] (el valor recomendado es 1, puesto que medimos sefiales con un nivel elevado) y
pulsamos el boton 'Calibrate’ [Calibrar]. Después de un segundo, tenemos el sistema calibrado.

Atencidn: Si cambiamos la longitud de la secuencia o la frecuencia de muestreo, tendremos que
repetir el procedimiento de calibracion.

La ultima seccion muestra un informe del procedimiento de calibracion. Lo mas importante es la
informacion sobre Channel difference [Diferencia entre canales] en dB. Si la diferencia entre
canales es mayor de 2 dB, LIMP avisa con un didlogo igual al que aparece en la ilustracion 4.16, y se
rechaza la calibracion.
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ump x|
'j Something is wrong: channel difference larger than 2dB!
L

Chedk whether left and right input channels are connected on generator output?
Chedk whether input level controls are at same position?

Check whether input probes have same gain

Check whether cables and connectors are OK?

llustracion 4.16 Informe que aparece cuando la diferencia de canales es mayor a 2dB.

4.8 Manejo de archivos

Los datos de impedancia se pueden guardar en formato binario propio de LIMP (archivos .LIM) y en
formato ASCII (archivos .TXT o .ZMA).

Ademas de los datos de impedancia, los archivos .LIM pueden contener texto definido por el usuario
de longitud arbitraria. El usuario podra introducir cualquier tipo de texto en el cuadro de edicion del
cuadro de dialogo File info [Informacion del archivo] (véase la Ilustracion 4.17). Este cuadro de
didlogo se puede abrir haciendo clic sobre el comando de menti Archivo > Informacion.

x

ile: Untitled
umPoints: 430
rom: 30.0Hz to 20000,0Hz

User supplied additional informations:

Impedance of woofer WX 100, ﬂ
Measured with stepped sine.

Date: 12.11.2005]

lHustracion 4.17 Cuadro de didlogo para la informacion del archivo

Los archivos de texto tienen la extension .txt o .zma. Contienen lineas de texto con tres textos
numéricos: Frecuencia (en Hz), magnitud (en ohmios) y fase (en grados). La linea finaliza con un
caracter de linea nueva.

La tnica diferencia entre los archivos .txt y .zma es que los archivos .txt pueden contener lineas de
comentarios. Las lineas de comentarios comienzan, después de un nlimero arbitrario de espacios o
tabs, con caracteres no numéricos mientras que las lineas de datos comienzan con un digito o un
punto.
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El archivo se podra guardar como datos de impedancia normales o como datos para el grafico de
superposicion. Sélo se permite una superposicion.

El formato de archivo binario .LIM es como sigue:

charid[4]  /l cuatro caracteres de identificacion {'L','I','M', \0' };
unsigned version;  // nimero de version — comienza a partir de 0x0101
unsigned reserved;,  // 0

int numdata; I/ nimero de puntos de datos

int cursorpos; /I Gltima posicién del cursor

int fftlen; Il'ongitud de FFT en la modalidad FFT

float fs; I frecuencia de muestreo

float data[3*numdata] // contiene la frecuencia, magnitud y fase
int infolength; /l'longitud de la cadena de informacion

char string[infolength]; // datos de la longitud de informacién
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5 Parametros de los altavoces

Este capitulo proporciona algunas definiciones y procedimientos de medicion para estimar los
parametros de los altavoces.

5.1 Definicién de los parametros fisicos y dinamicos de los altavoces

Un altavoz electrodindmico montado en una caja infinita se caracteriza por los siguientes parametros
fisicos:

Parametros electromagnéticos:

RE — Resistencia DC de la bobina de voz ()

LE — auto-inductancia de la bobina de voz (H)

L2 - inductancia debida al acoplamiento inductivo de las corrientes de Eddy (H)

R2 — resistencia debida a las corrientes de Eddy (€2)

BI - factor de fuerza(Tm)

Parametros mecanicos:

S — area efectiva de la membrana (m2)

Cws —elasticidad de la suspension (m/N)

Mwms —masa mecanica de la membrana mas masa de aire que carga la membrana (Kg.)
Rwms — resistencia mecanica mas resistencia a la radiacion de la membrana (Kg./s)

(El area del piston se obtiene normalmente con la medicion del didmetro del cono incluyendo el 1/3
del borde).

La ilustracion 5.1 muestra los circuitos equivalentes de baja frecuencia de un altavoz electrodinamico
montado en una caja infinita. Los circuitos usan los siguientes elementos:

L,

R L, BI

E

R,

Electrical circuit Mechanical circuit a)
L VAVAVAY
RF
Lcgs R.‘:..‘u' — C_-'L.'ES
r m

Z - Low frequency
inpui mmpedance

b)
LCES =(BI)2CMS’ RES Z(Bl)z/RMS7 CMES = MMS /(B|)2

Figura 5.1 a) Circuito eléctrico de un altavoz electrodinamico de banda ancha montado en un baffle
infinito, y b) circuito para el calculo de la impedancia de entrada de baja frecuencia.
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Usando estos elementos, Thiele y Small [6, 7] introdujeron los parametros dindmicos de los altavoces
que se definen en la Tabla 5.1.

1 1
Frecuencia de resonancia en aire libre fs = o, =
(Hz) 272\MysCs VM sCus

Factor Q Mecanico Qus = ©sMus = 1
Rus @3CsRys
oM ,,.R
Factor Q Eléctrico Qgs = : (B;Vl)sz -
ReRes Quis Qes
Factor Q Total Qrs = @5Cpyes =
Re +Res Qus + Qg
2 2
Eficiencia de Potencia Disponible (%). o = &LBI)Z
27C RcM 6
Sensibilidad (1W/1m) en dB L, (IW /1m) = lOlog[g—OC %J - 2010g(pref ) =112,1+10log(n,)
V4
Volumen aciistico equivalente (m®) Vas = Poczsszs

Tabla 5.1 b) Parametros dinamicos de los altavoces de Thiele - Small
( po=1.18kg/m’, ¢ = 345m/s, prer= 20Pa)

Thiele y Small han demostrado que usando estos parametros es sencillo expresar la respuesta de una
caja cerrada como un filtro de paso alto de 2° orden y la respuesta de una caja bassreflex como un
filtro de paso alto de 4° orden.

Hoy en dia, casi todos los fabricantes de altavoces incluyen los parametros fisicos y los parametros de
Thiele-Small en las hojas de datos de sus altavoces.

Nota sobre inductancia eléctrica:

En la industria estdndar se mide la inductancia de la bobina de voz a 1 Khz. En LIMP, un componente
inductivo (también uno capacitativo) puede ser medido a cualquier frecuencia, como muestra el
capitulo 4.6.

Lo cierto es que nosotros no podemos especificar el exacto valor de la inductancia de la bobina de voz
LE, porque esto es un elemento que depende de la frecuencia. La inductancia de la bobina de voz
mejor puede ser descrita como una bobina primaria del “transformador” cuyo secundario se arroya
sobre la pieza polar

Las corrientes de Eddy en la pieza polar llevan a aumentar la resistencia del circuito primario.

El modelo simple [8] para una impedancia de entrada primaria es KNo + jKVo, donde K es una
constante. La impedancia se incrementa con Ve antes que con .

Este modelo no es practico como los ingenieros en muchas simulaciones numéricas usan alguna forma
de un circuito analogo eléctrico que estrechamente empareja datos de medida. El circuito mas
comunmente usado para impedancia eléctrica de bobina de voz es una conexion serie de resistencia Re,
inductor Lt y conexidn paralela de resistor R.e inductor L., como muestra la Fig. 5.1. Ha sido probado
como el modelo util en muchas simulaciones. LIMP estima el valor de LE, Ry L2 ajustando la
respuesta del circuito modelo a los datos medidos, por el método de error del minimo cuadrado.
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(Quiere decir que el valor de L2 y R2 es cambiado hasta que la suma de cuadrados de las diferencias
de la respuesta de modelo y respuesta mesurada se hace minima)

La resistencia de la bobina mdvil se deberia medir con un ohmiémetro CC.

5.2 Estimacion de los parametros Thiele-Small

Sera facil estimar los parametros Thiele-Small una vez que hayamos medido los datos de la
impedancia del altavoz.

En las frecuencias bajas la influencia de una inductancia de bobina movil es pequeiia y una expresion
de la impedancia de entrada del altavoz tendra la siguiente forma:

Sy
7o B Qu o 14sT/Q ST

"R 2 14T, /Qye +5°T.

Sw.
MS @+ S+
MS
Donde s=jw, Ts= 1/w;.

La impedancia encuentra su maximo valor en la frecuencia de resonancia:

Z. . =Z(w=ws)=R.Qg /Q; =R +Rg

max

Ya que Qes>Qr.

-Zl'l'lcl'\u

zl.l

R

A f T

lHustracion 5.2 Curva tipica de impedancia de un altavoz montado en aire libre

En las frecuencias f; y f, (donde fi<fs<f2, fif2= fs2) los valores de impedancia son de igual
magnitud;

|Z(jw1) :|Z(ja)2] =hRe, if oo, :a)s2

Si sustituimos esta expresion en la ecuacion de impedancia, obtenemos

‘Z(J'w f =r’R.>=R.’ r," +(Qus(® - ,)/ o)
1,2 1 R E 1+(Q'V'S(w1_a)2)/a)s)2
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A partir de esta ecuacion obtenemos el factor Q mecanico:

2 2
fs Lh —h

Z_fl r12—1

QMS:f

Ahora podremos definir un procedimiento paso a paso para medir los factores Q:
1. Medir una resistencia de bobina mévil Rg con un ohmiéometro CC.
2. A partir de la curva de la impedancia, hallar fs y Zmax. Definir ro=Zmax/RE.

3. Elegir alguna magnitud de impedancia RE<|Z;|<Zmax y hallar las dos frecuencias (f1 y f2) en las
que Z = Z;. Definir r1=2,/REe.

4. Calcular QMs (con la ecuacion anterior),
5. Calcular QEs con la ecuacion Qes=Qms / (ro-1).

6. Calcular QT con la ecuacion Q=QesQEes/ (Qes+QEs).

5.3 Estimacion de los parametros fisicos del altavoz

Se usan dos métodos [7] para estimar los parametros fisicos de un altavoz (Mwms, CMs y Rms);

1. Meétodo de la masa anadida
2. Meétodo de la caja cerrada.

Ambos métodos se pueden aplicar con el LIMP,

5.3.1 Método de la masa afadida

En este método, primero medimos la curva de la impedancia y estimamos los parametros de Thiele-
Small fg, Qms y QEs, para el altavoz montado en el aire libre. A continuacion colocamos una masa
anadida (M,qdeq) @ la membrana, medimos la curva de la impedancia y estimamos la frecuencia de
resonancia nueva fy y el factor Q eléctrico Qgpm. A partir de las ecuaciones para Qpm y Qs
obtenemos:

M
M — added
MS fS QEM _ 1

fM QES

Una vez que conocemos Mms y fs, es sencillo obtener la elasticidad mecanica Cys, la resistencia Rys y
el factor de fuerza Bl. Usando las ecuaciones definidas en la Tabla 5.1 obtenemos

C :—1 Bl = ’a)SMMSRE R _wsM ¢
MS M 2 _ 2 2 Q MS -
s @s ’ Vs =p,C°S CMS’ ES Qus
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5.3.2 Método de la caja cerrada

En este método, primero medimos la curva de la impedancia y estimamos los parametros de Thiele-
Small fg, Qms y QEs, para el altavoz montado en el aire libre. A continuacion montamos el altavoz en
una caja cerrada, con un volumen Vg conocido, medimos la curva de impedancia y estimamos los
parametros de Thiele-Small fc, Qmc, Qec. A partir de estos hallaremos

f.Q
V.. =\ (—C<EC _1
AS B(fSQES )

Entonces, usando las ecuaciones definidas en la Tabla 5.1 obtenemos

vV 1 oM R oM
Cus = Azs r My = C ; Bl :w/ S~ Rys ===
PoC°S , ms Ps Qes Qus

B 1

5.4 Estimacion automatica de los parametros fisicos y dinamicos de los
altavoces

Los procedimientos LIMP para la estimacion de los parametros del altavoz son los siguientes.

Para estimar los factores Q de un altavoz necesitamos:

1. datos de la impedancia medida,

2. resistencia CC de la bobina mévil medida (en ohmios)

3. diametro estimado de la membrana en cm. (medicion del didmetro del cono que incluye el 1/3
del borde).

Haciendo clic sobre el menti Analyze > Pardmetros del altavoz — Método de la suma de masas,
obtendremos el cuadro de dialogo 'Loudspeaker Parameters — Added Mass Method® [Parametros
del altavoz — Método de la masa afiadida] que se muestra en la ilustracion 5.2.

En este cuadro de dialogo, se introducen los valores de Voice coil resistance [Resistencia de la
bobina movil] y Membrane diameter [Didmetro de la membrana]. Pulsar sobre el boton
'Calculate’ [Calcular] para obtener el informe que aparece en la caja de edicion a la izquierda. Este
informe se puede copiar al portapapeles pulsando el boton 'Copy’ [Copiar].

Loudspeaker Parameters - Added Mass Method x|
Thiel-Small parametsrs: a|  Yser Input
Fs = 64,84 Hz Voice coil Resistance (ohms) I 3.6
Re = 3.60 Ohms[dc]
oF =0,99
Ges = 1,27 Membrane diameter (cr) I 15
oms =4.53
Load overly data, Added mass (g) I 10
to calculate all parameters!

Calculate I Cancel |
B

lustracion 5.2 Cuadro de dialogo para estimar los factores Q del altavoz
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5.4.1 Método de la masa afadida

Para estimar todos los parametros fisicos y dinamicos del altavoz hemos de hacer dos mediciones de
impedancia del altavoz en el aire libre. En una de esas dos mediciones, la membrana se ha de cargar
con una masa adicional. Esto es lo que necesitamos:

1.
2.

AN S

datos de la impedancia medida,

datos de la impedancia medida con una masa adicional en la membrana (como en la
[lustracion 5.3),

una de las curvas (1 o 2) se ha de configurar como grafico de superposicion,

masa adicional medida — en gramos.

resistencia CC de la bobina moévil medida - en ohmios,

diametro de la membrana - en cm. (didametro del cono que incluye el 1/3 del borde).

12.0
16.0
14.0
12.0
10.0
s.0
G.0
4.0
20
o0

Magnitude(ohms) Impedance
]
ﬁI EH
J'd
AN '
= | N it
100 1000 10000

Cursar. 1735 Hz, 404 Ohm FrequencyiHz)

lustracion 5.3 Curvas de impedancia (la de la frecuencia de resonancia menor se obtiene afladiendo

masa a la membrana)

A continuacion activamos el menti Analyze > Pardmetros del altavoz — Método de la masa
afadida, para obtener el cuadro de dialogo "Loudspeaker Parameters' [Parametros del altavoz]
que se muestra en la ilustracion 5.4.

Loudspeaker Parameters - Added Mass Method

X

Thiel-Small parameters:

Fs =6&4.84 Hz

Re =3.60 Chms[dc]
ot =0,99
Qes=1.27

Qms = 4.53

Mms = 24,10 grams
Rms = 2,166225 kgj's
Crns = 0,000250 miM
Wag = 10,96 liters
Sd=176.71 cmz2

Bl =5.277639 Tm
ETA =023 %
Lp(z.83%/1m) = 89,12 dB

Mass loaded method:
Added mass = 20,00 gr
Diameter= 15.00 cm

—User Inpukt

Woice caoil Resistance (ohms) I 3.6
I 15
I 20

-

Membrane diameter {cm)

Added mass (g)

Cancel |

Calculate I

Capy |

=

QK |

llustracion 5.4 Cuadro de dialogo para estimar los parametros del altavoz

Finalmente, introducimos los valores de Voice coil resistance [Resistencia de la bobina movil],
Membrane diameter [Diametro de la membrana] y Added mass [Masa afiadida]. Pulsar sobre el
boton 'Calculate’ [Calcular] para obtener el informe que aparece en la caja de edicion de la izquierda.
Este informe se puede copiar al portapapeles pulsando el boton 'Copy’ [Copiar].
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5.4.2 Método de la caja cerrada

Para estimar todos los parametros del altavoz hemos de tener dos mediciones de impedancia. En una
de las mediciones el altavoz ha de estar montado en una caja cerrada de volumen conocido. Esto es lo
que necesitamos:

1. datos de la impedancia medida,

datos de la impedancia medida con el altavoz montado en una caja cerrada,

una de las curvas (1 o 2) se ha de configurar como grafico de superposiciéon (como en la
Ilustracion 5.5),

4. valor estimado del volumen de la caja - en litros.

w N

5. resistencia CC de la bobina movil medida - en ohmios,
6. diametro de la membrana - en cm (diametro del cono que incluye el 1/3 del borde).
0 Magnitudeiohms) Impedance
120
6.0 f

::-3 ;
| | /

10.0 f Il 7
2.0 .
B.0 l/.l"I H| . /I
e _,--""‘ ‘\..:I‘\_a.‘_ _,_._o—-"'"'f'
an
20
0.0
100 1000 10000
Cumsor 2642 Hz, .15 Ohm FreguencyiHz)

lustracion 5.5 Curva de impedancia (la de la frecuencia de resonancia mas alta se obtiene montando
el altavoz en una caja cerrada)

A continuacién activamos el menta Analyze > Parametros del altavoz — Método de la caja cerrada,
para obtener el cuadro de dialogo ‘Loudspeaker Parameters — Closed Box Method' [Parametros
del altavoz — Método de la caja cerrada] que se muestra en la ilustracion 5.6.

Loudspeaker Parameters - Closed Box Method x|
Thigl-Small parameters: - - User Input
Fs =64.54 Hz Voice coil Resistance {ohms) I 3.6
Re = 3.60 Ohms[dc]
QF =099
GQes= 1,27 Membrane diameter (om) I 13
Qms = 4,53
Mms = 21.13 grams
Rrits = 1.3993?54 kajs Closed baox volume (it} I 11
Crins = 0,000285 /M
Was = 12,50 liers

Sd= 176,71 cmz
Bl =4.941864 Tm

ETé = 0.26 % [},
Lp(2.83v/1m) = 59,69 dB

Closed box method: Calculate I Cancel |

Bioe wolurme = 11,00 lic —
Diarneter= 15,00 cm _I |
- Copy oK |

lustracion 5.6 Cuadro de dialogo para estimar los parametros del altavoz método de la caja cerrada

Finalmente, introducimos los valores de Voice coil resistance [Resistencia de la bobina mévil],
Membrane diameter [Diametro de la membrana] y Closed Box volume [Volumen de la caja
cerrada]. Pulsar sobre el boton 'Calculate’ [Calcular] para obtener el informe que aparece en la caja
de edicion de la izquierda. Este informe se puede copiar al portapapeles pulsando el boton 'Copy"
[Copiar].
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6 Medicion de RLC

El Limp se puede emplear para medir los valores de resistencias, condensadores e inductores,
simplemente mediante el calculo de las partes resistivas, inductivas o capacitativas de la impedancia
medida. Por ejemplo, la Ilustracién 6.1 muestra las curvas de impedancia de un inductor con un valor
nominal de 1,5 mH.

Magnitude{ohms) Impedance Fhase (%)
2380 90.0
.-..-.--'-"'__-_
2142 —_— 45.0
180.4 0.0
188.6 [ -45.0
1428 f’f 800
119.0 .
f Aug:0
952
J'r'
71.4 v L
I
478 - el
-1 I
228 ] =
-—-'-'-'-__-'
a.a 100 1000 10000
Cursor: 1983.0 Hz, 19.82 Chm, 87.7 deg Frequency{Hz)

lustracién 6.1 Grafico de impedancia de un inductor de 1,5mH

Haciendo clic sobre el comando de menu Analysis > RLC Impedance value at cursor position
[Anélisis > Valor de impedancia RLC en el cursor] obtendremos el cuadro de didlogo con informe
que aparece en la ilustracion 6.2. El programa informa de que la impedancia medida tiene una parte
resistiva de 0,776 ohmios y la parte imaginaria tiene un valor inductivo de 1,589mH.

i
Impedance |Z] = 19.6206 at f = 1962,963623Hz
! is inductive: Z =R +jwL
R=0.776987 ohm, L=1.58957 mH

lustracion 6.2 Impedancia de un inductor con nucleo de aire

De la misma forma, LIMP mide la capacitancia.
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6.1 Importancia de la calibracion

Al medir la impedancia y la capacitancia es muy importante hacer la calibracion del
sistema antes de la medicion, y sera mejor hacer la calibracién con la impedancia
conectada (Dispositivo a probar).

¢Por qué?

Incluso aunque haya una diferencia muy pequefia entre las sensibilidades de los canales (por ejemplo
de 0,1 dB) el LIMP puede dar un resultado muy erréneo, puesto que la impedancia del inductor tiene
una fase cercana a los 90 grados, y la impedancia de la capacitancia tiene una fase cercana a menos 90
grados. En ese caso, si hay una diferencia en la sensibilidad del voltaje medido del generador, V1, y
del voltaje de la impedancia, V2, (si la sensibilidad de la sonda V2 es mayor que la sensibilidad de
V1), la impedancia estimada nos da unos valores de fase por encima de los 90 grados y en el grafico
nos encontramos con un salto en la fase de 180 grados. La Ilustracion 6.3 muestra el caso de la
medicion de un condensador sin calibracion. A la mitad de la gama, la fase se encuentra cerca de los
90 grados. Es un resultado muy erréneo puesto que sugiere que tenemos que tratar con una
inductancia. La [lustracion 6.4 muestra la impedancia del condensador después de la calibracion
Vemos los valores correctos para la fase en toda la gama de frecuencias.

Magnitude{ohms) Impedance Fhase (%)
1245.0 - 20.0
=
1120.5 — 45.0
2880 \ 0.0
871.5 Y -45.0
747.0 L -80.0
8225 \
. Awg:D
485.0 ‘.,H
3735 i L
2430 N '
""'--._‘__ M
124.5 =
—
0.0
100 1000 10000
Cursor: 1009.3 Hz, 32.82 Chm, 89.7 deg Frequency{Hz)

lustracion 6.3 Impedancia estimada errdbneamente para un condensador plastico de 4,7uF/250V
(medido sin calibracion)
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Magnitudelohms) Impedance Phase (*)

1245.0 80.0
1120.5 45.0
888.0 l“'\ 0.0
B71.5 1 -45.0
T47.0 .."| -80.0
£a2.8 Awg: B
435.0 ‘\\

373.5 M L
248.0 M, '

s e "“'i-..._h M
124.5 L] =

0.0
100 1000 10000
Cursor: 2427 Hz, 132.98 Ohm, -89.4 deg Frequency{Hz)

lustracion 6.4 Impedancia estimada correctamente para un condensador plastico de 4,7uF/250V
(medido después de la calibracion)

No todos los usuarios de LIMP tendran este problema. Tal como se ha explicado antes, el problema
aparece cuando la sonda para el voltaje de la impedancia V2 tiene una sensibilidad mayor que la
sensibilidad de la sonda para el voltaje del generador V1. Para evitar este problema podremos cambiar
la sensibilidad de las sondas o podremos simplemente intercambiar los canales de entrada y también
cambiar el canal de referencia en la configuracion de medicion LIMP.

Nota:

Para obtener una buena estimacion de la capacitancia o inductancia se recomienda poner el cursor
sobre la frecuencia cuando la magnitud de la impedancia sea inferior a 100 ohmios. Se garantiza una
medicion de la impedancia con un 1% de tolerancia. ;Por qué? La respuesta se encuentra en el hecho
de que la impedancia medida se anula con la impedancia de la sonda o de la entrada de la tarjeta de
sonido que normalmente tiene un valor de 10k ohmios.
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